
File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save All Saves all modified documents using the same file names.
Save As Saves an opened document to a specified file name.
Save Selection As Save Selection to a new file
Send Mail Send file via mail to recipients.
Insert File Inserts a file into the active document.
UNIX/MAC to DOS Converts the file format from UNIX or MAC to DOS.
DOS to MAC Converts the file from DOS to MAC format.
DOS to UNIX Converts the file from DOS to UNIX format.
Sort File Sort the file based on current sort options.
Advanced 
Sort/Options File

Advanced Sorting and sort options.

Delete Active File Deletes the disk file associated with the active window and closes the 
window losing all changes.

Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Page Setup Set up page headers and footers for printing.
Print Setup Selects a printer and printer connection.
Exit Exits UltraEdit.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Redo Reverse the previous UNDO command.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.

Select All Selects all the text in the active document.
Select Line Selects the line with the cursor.
Delete Line Deletes the line with the cursor.
Find Search document for a text string.
Find Next Repeat the last find.
Replace Search document for a text string and replace it with another text string.
Find In Files Search files on disk for a text string.
Goto Line/Page Position the cursor at the specified line or page break (or file position in HEX mode).
Find Matching Brace Find and highlight between matching braces.
Hex Edit Toggles the state of the editing mode for the current window between HEX

and ASCII.
Hex Insert/Delete Presents a dialog allowing insertion or deletion of bytes in a file while in HEX

editing mode.
Spell Check Invoke the spelling checker, and check the complete file or selected text.
Read Only Toggle the READ ONLY state of the active file.



Format menu commands

The Format menu offers the following commands:

Reformat Paragraph Reformat paragraph to wrap at column number with hard returns.
Convert CR/LF's to 
Wrap

Convert CR/LF's to Word Wrap for selected text.

Convert Wrap to 
CR/LF's

Convert Word Wrap to hard CR/LF's for complete file.

OEM to ANSI Convert OEM character set to ANSI character set.
ANSI to OEM Convert ANSI character set to OEM character set.
To Upper Case Converts the selected text to upper case.
To Lower Case Converts the selected text to lower case.
Capitalize Capitalize first character of each word in selected text.
Invert Case Invert the case (lower/upper) of each character of selected text.
Add Indents Presents a dialog to allow adding indentation to selected rows of text.
Remove Indents Presents a dialog to allow removing indentation from selected rows of text.
Insert Page Break Inserts a page break at the cursor position.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Toggle Bookmark Toggles a bookmark at the current line.
Next Bookmark Move the cursor to the next bookmark.
Set Font Select the screen font to use.
Set Printer Font Select the printer font to use.
Mirror Display Font Use display font for the printer.
Reset Fonts (Default) Reset the screen and printer fonts to default settings.
Set 
ColorsHID_SETTEXT
COLOR

Set the screen colors for text, background and 
bookmarks.

Show Spaces/Tabs Show spaces, tabs and new line characters as visible 
characters.



Column menu commands

The Column menu offers the following commands:

Column Mode Select column/block mode editing.
Insert/Fill Columns Specify the text to insert into each column.

Delete Columns Specify how many/which columns to delete.

Cut Columns Specify how many/which columns to cut.

Insert Number Specify number range to insert into each row.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

Duplicate Window Creates a duplicate window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Horizontal Arranges windows in non-overlapped horizontal tiles.
Tile Arranges windows in non-overlapped vertical tiles.
Next Window Makes the next window active.
Previous Window Makes the previous window active.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in UltraEdit.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document (file) in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.    See 
Window 1, 2, ... command.

This command presents the File Open dialog.    This allows multiple files to be selected and opened at 
one time.

Files may also be opened by dragging them from the File Manager into UltraEdit's window and dropping 
them. (Releasing the mouse button).

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
    *.*

Drives
Select the drive in which UltraEdit finds the file that you want to open. 

Directories
Select the directory in which UltraEdit finds the file that you want to open.

Read Only
Check this item to open a file in a read-only manner.    Modifications will be disabled.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

UltraEdit allows multiple files to be selected from the file list and opened at one time (Except UltraEdit-32 
on Windows NT*See below).    To select multiple files,    select the first file from the list, then with the CTRL 
key pressed, select other files in the list.    When all files are selected,    select OK and the selected files 
will be opened.

Files may also be opened by dragging them from the File Manager into UltraEdit's window and dropping 
them. (Releasing the mouse button).

*The normal operation of Windows NT does not permit the selection of long filenames, and multiple 
selection from the open dialog.    To facilitate both operations, the open dialog box normally allows single 
selection with long filenames.    If however the SHIFT key is pressed while the file open dialog is invoked 
multiple selections are permitted with short file names.



Close command (File menu)

Use this command to close all windows containing the active document.    UltraEdit suggests that you 
save changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, UltraEdit displays 
the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, UltraEdit displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the Save 
As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    UltraEdit displays the Save As dialog box so 
you can name your document. 

To save a document with its existing name and directory, use the Save command.



Save Selection As command (File menu)

Use this command to save the current selection to a new file..    UltraEdit displays the Save As dialog box 
so you can name your document. 



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters. 

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your UltraEdit session.    You can also use the Close command on the 
application Control menu.    UltraEdit prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      UltraEdit supports multiple levels of 
undo (the specific number varies based on the items being undone).    Repeated Undo commands will 
attempt to step backwards through the previous commands and undo one at a time.    The Redo 
command may be selected to redo a command that has been undone.    If commands are undone and 
then a new command is performed, the Redo will nolonger allow previous undon actions to be redone.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

The Redo command allows commands that have previously been undone with the Undo to be redone. 
If commands are undone and then a new command is performed, the Redo will no longer allow previous 
undo actions to be redone.

Shortcuts
Keys: CTRL+A



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in UltraEdit, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in UltraEdit.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    UltraEdit displays the Open dialog box, in which you can locate and 
open the desired file.

Close an existing document.    If the document has been modified, UltraEdit displays a dialog 
asking if the changes should be saved.

Save the active document or template with its current name.    If you have not named the 
document, UltraEdit displays the Save As dialog box.

Print the active document.

Display the active document as it will be printed.

Insert a page break character into the file at the cursor position.

Toggle the Word-Wrap mode.

Toggle the HEX/ASCII editing mode.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Display the find dialog to search for a string.

Repeat the last find command.



Display the find and replace dialog.

Goto the specified line number or page break (or address in HEX mode).

Make the next document window active.

Make the next document window active.

Horizontally arrange multiple opened windows in a non-overlapped fashion.

Vertically arrange multiple opened windows in a non-overlapped fashion.

Cascade multiple opened windows in an overlapped fashion.

Display about box for UltraEdit.

Change the mouse pointer to a ? that displays help when clicked on an item.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the UltraEdit window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The middle area of the status bar indicates line number (if enabled) of the cursor in the file, the column 
number, the date and time the active file was last modified (prior to this session), and the file size.    For 
new files the date and time shown is the creation date and time.    The file size is updated when UltraEdit 
writes any changes to the disk.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
OVR The Overstrike mode is selected.
CAP The Caps Lock key is latched down.



Duplicate Window command (Window menu)

Use this command to open a new duplicate window with the same contents as the active window.    You 
can open multiple document windows to display different parts or views of a document at the same time. 
If you change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a duplicate window, it becomes the active window and is displayed on top of 
all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

UltraEdit displays a list of currently open document windows at the bottom of the Window menu.    A check 
mark appears in front of the document name of the active window.    Choose a document from this list to 
make its window active. 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using UltraEdit and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of UltraEdit.



Context Help command 

Use the Context Help command to obtain help on some portion of UltraEdit.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the UltraEdit window, such as another Toolbar button.    The Help topic will be shown for the 
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

UltraEdit - <filename>

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.

The horizontal scroll bar is used to position within the current document. The vertical scroll bar is used to 
change the horizontal viewing area of the document.

The horizontal scroll bar is not shown if WORDWRAP mode is selected.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move. 
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the UltraEdit window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    UltraEdit determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    UltraEdit determines which window 
is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the UltraEdit window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





Choose Font dialog box

UltraEdit allows selection of fonts for the screen and printer.    The selection of screen fonts will also apply 
to the printer if the Mirror Display Font menu item is checked on the View Menu.    If this item is not 
checked,    the printer fonts have been selected independently from the screen fonts.

The Font dialog is presented when font selection is selected from the View Menu.    It will be presented if 
either the Set Font or the Set Printer Font is selected.

The Font dialog presents a selection of installed fonts that may be selected    for use.    If the fonts are 
being selected for the printer, only fonts applicable to the printer are available.    Selection of font and font 
size is available.





Find command (Edit menu)

This command displays a dialog box for searching the document for the specified text.    In addition to 
searching for printable characters,    Tab characters and newline (Carriage Return/Line Feed) characters 
may be searched for.    To search for a Tab character, use "^t" characters in the dialog.    To search for the 
newline characters, use "^p" characters in the dialog.    To search for a "^" character, use "^^" in the dialog.

Additionally, the characters "^s" will be replaced with any text that is highlighted when a find is executed 
and the characters "^c" will be replaced with the contents of the clipboard (upto 200 characters).    This is 
useful particularly for macros.    When recording a macro, the option exists to include a find of a specified 
character string, or using "^s" the macro records the "^s" and when replayed will determine the text 
highlighted at the time the macro is playing back, likewise when using "^c", these characters will be 
replaced with the contents of the clipboard at the time the macro is playing back.

Special character summary:
Symbol Function

^^ searches for a "^" character
^s searches for selected (highlighted) text when a macro is 

running
^c searches for the contents of the clipboard when a macro is 

running
^p Matches a newline(paragraph)
^t Matches a tab character

To select all text between the cursor position and the search target, hold down the SHIFT key at the time 
the search is started with the FINDNEXT button.

The following search options exist:

Search Direction
The default search direction is down (toward the end of the document). The option to search up or 
down the document is given. If a search has already occurred in the document, the default search 
direction is that of the previous search.

Match Case
By default, the search will not be case sensitive. The option to make the search case sensitive is 
given. If a search has already occurred in the document, the default selection for case sensitivity is 
that of the previous search.

Regular Expressions:
Symbol Function

? Matches any single character except newline
* Matches any number of occurrences of any character except 

newline
^p Matches a newline(paragraph)
^t Matches a tab character
[ ] Matches any single character, or range in the brackets
^ Overrides the any following regular expression character

Examples:
m?n matches "man", "men", "min" but not "moon".



t*t matches "test", "tonight" and "tea time" (the "tea t" portion) but not "tea
time" (newline between "tea " and "time").

[aeiou] matches every lowercase vowel
[,.?] matches a literal ",", "." or "?".
[0-9, a-z] matches any digit, or lowercase letter
[~0-9] matches any character except a digit (~ means NOT the following)

If the editor active window is in HEX mode, an additional option exists:

ASCII
By default, in HEX mode, the search will be for hexadecimal characters.    Optionally the find may be 
configured to search for ASCII characters.

When a find operation is complete the text is highlighted.

Shortcut
Keys: ALT+F3 or Ctrl+F



Find Next command (Edit menu)

This command repeats the previous FIND command. The next occurrence of the find text will be found (if 
present) in the same direction as the previous find command.

To select all text between the cursor position and the search target, hold down the SHIFT key at the time 
the search is started with the FIND NEXT menu item or shortcut key.

Shortcut
Keys: F3

@Normal@





Replace command (Edit menu)

This command displays a dialog box for searching the document for the specified text, and replacing it 
with a different text.

In addition to searching and replacing printable characters,    Tab characters and newline (Carriage 
Return/Line Feed) characters may be searched for or replaced.    To specify a Tab character, use "^t" 
characters in the dialog.    To specify the newline characters, use "^p" characters in the dialog.    To specify 
a "^" character, use "^^" in the dialog.

Additionally, the characters "^s" will be replaced with any text that is highlighted when a find is executed 
and the characters "^c" will be replaced with the contents of the clipboard (upto 200 characters).    This is 
useful particularly for macros.    When recording a macro, the option exists to include a find of a specified 
character string, or using "^s" the macro records the "^s" and when replayed will determine the text 
highlighted at the time the macro is playing back, likewise when using "^c", these characters will be 
replaced with the contents of the clipboard at the time the macro is playing back.

Special character summary:
Symbol Function

^^ searches for a "^" character
^s searches for selected (highlighted) text when a macro is 

running
^c searches for the contents of the clipboard when a macro is 

running
^p Matches a newline(paragraph)
^t Matches a tab character

The following replace options exist:

Find Next
Find next finds the next occurrence of the specified text.

Replace
Replace finds the next occurrence of the specified text and replaces it with the new text.

Replace All
Replace all finds every occurrence of the specified text and replaces each occurrence with the new 
text.

Match Case
By default, the search will not be case sensitive. The option to make the search case sensitive is 
given. If a search has already occurred in the document, the default selection for case sensitivity is 
that of the previous search.

If the editor active window is in HEX mode, an additional option exists:

ASCII
By default, in HEX mode, the search will be for hexadecimal characters.    Optionally the find may be 
configured to search for ASCII characters.

When a find operation is complete the text is highlighted.    In HEX mode additional characters may be 
highlighted if the specified search string crosses a line.    In this case, all characters displayed from the 
first character of the search string on the first line to the last character of the search string on the last line 
are highlighted.    If a replace is requested, only the search string will be replaced.



Shortcut
Keys: CTRL+R



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4







 





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>
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Macro menu commands

The Macro menu includes commands that let you record and playback macros, load and/or save them.

What is a macro?

A macro is a series of keystrokes or actions that have been 'recorded' in    the order performed. A macro 
allows you to 'record' a series of keystrokes or actions and then 'playback' or repeat the recorded 
keystrokes and/or actions. A macro is typically used to perform a similar set of actions, multiple times on 
each occurrence of a given text string.

UltraEdit supports multiple macros, and one macro may invoke another macro.    When a macro is defined 
a hot key may be chosen to invoke the macro.

Macros may be automatically loaded and executed when the editor starts up.    See the Command Line 
Parameters for more information.

For more information, select the Macro menu command name:

Load Macros Loads a macro file.
Save all Macros Saves all macros to a file.
Delete Macro/Modify Hot 
Key

Delete a macro, or modify its Hot key.

Record a Macro Starts recording a macro.
Stop Recording a Macro Stops recording a macro.
Play again Playback last macro again.
Playback any macro or 
play a Macro Multiple 
Times

Playback any macro, or playback a macro multiple times.

Advanced menu commands

The Advanced menu provides access to some of the advanced capabilities of UltraEdit.    These include:

Configuration: A Tabbed dialog with access to the following pages:
General Items
Tab Settings
File Types
Syntax Highlighting

Display/Modify 
Templates

Display or modify the user definable templates.

Insert Template Insert a user defined template into the file.
DOS Command Run a DOS command and capture its output.
Last DOS Command Repeat the last DOS command.

Run Windows Program Run a Windows program.



Macro Load (Macro menu)

The Macro Load command presents a dialog box for loading a previously saved set of macros from a disk 
file. The dialog box allows selection of a file from any file device known to the system. The default file 
name presented is UltraEdit.MAC, although any filename is acceptable.

When a file is selected for loading, a check is made to ensure the file is an UltraEdit macro file.



Macro Save All (Macro menu)

The Macro Save All command presents a dialog box for saving the macros that have been recorded using 
the Macro Record command to a disk file. The dialog box allows selection of a file from any file device 
known to the system. The default file name presented is UltraEdit.MAC, although any filename is 
acceptable.

This command is available only if a macro has been recorded, or loaded.



Delete Macro/Modify Hot Key (Macro menu)

This command allows the user to delete a macro, or modify the hot key associated with any macro.    A 
dialog box is presented, that shows all of the macros, and allows any macro to be selected and its hot key 
modified (or the macro may be deleted).    No support is provided to modify the contents of a macro.    For 
more details on the hot key assignments see Macro Recording.



Macro Record (Macro menu)

The Macro Record command starts 'recording' keystrokes and actions for later playback. Recording is 
stopped when the Stop Recording menu selection is made. 

This command presents a dialog box that allows a name to be given to the macro, and a hot key 
assignment to be given to the macro, after pressing OK the macro recording starts.

The hot key assignment allows the user to specify a key combination that will automatically invoke the 
macro.    If a key assignment is chosen that is already used by UltraEdit the key assignment will override 
UltraEdits assignment.

The following keys are supported:
A-Z
0-9
F1-F12
Space, Enter and Tab

In addition, the key modifiers CONTROL, ALT and SHIFT may be selected.

It is not required that a name be entered, or a hot key assignment be made.

Notes for recording macros:
The Macro Record function records all keystrokes and characters typed while recording is selected. All 
keystrokes are recorded, including key combinations that move to end of line, top or bottom of document 
etc. Care should be taken to ensure that when the macro is to be Played back the same keystrokes are 
appropriate.

Mouse motion and scrolling is NOT recorded while recording is selected. All positioning should be 
performed with the keyboard.

Macros will record and playback the Next Window and Previous Window commands.

Find and Replace is supported while recording is selected (see Find for special characters that are useful 
with macros). Any find or replace functions will be recorded directly as performed, unless using special 
characters that are replaced when executing with the contents of the clipboard or the highlighted text, see 
Find. If all, or any occurrences of "FIND" are replaced with "REPLACE" in a file, the same action will be 
performed when the macro is Played back.

Cut, Copy and Paste are also supported while macro recording is selected. Any of these operations will 
be performed dynamically as the macro is Played back. That is to say that if an item is cut while recording 
the macro, an item will be cut while playing back the macro based on the selected text at the time the 
macro is being played back. If the selected text is different while playing back the macro, from when the 
macro is recorded, the text cut while playing back the macro will also be different.

As multiple macros are now supported, this command is available when macros already exist.

HEX editing is now supported within macros.

The following commands are supported when recording a macro:

Keyboard entry - typing characters
Cursor positioning



Selecting text with keyboard commands
Cut, copy, paste
Find/replace
HEX mode switching and editing
File open, close, save
Bookmarks
Playing macros - nesting macros
Window switching - next/previous window
Insert/Overstrike selection
Unix/Mac to DOS
DOS to Unix
DOS to MAC
Convert Wrap to CR/LFs
Convert CR/LFs to Wrap



Macro Stop Recording (Macro menu)

The Macro Stop Recording command stops capturing keystrokes and actions that was started when the    
Macro Record function was selected. Once a macro has been recorded and the session has been 
stopped with this command, the macro may be played back by selecting the Macro Play Again or Macro 
Play Any/Multiple Times    command.

After a macro has been recorded, it may by saved using the Macro Save All command.



Macro Playback (Macro menu)

The Macro Playback command allows a macro that has been recorded with the Macro Record command 
to be replayed. The macro is replayed one time for each invocation of the command. To replay the macro 
multiple times use the Macro Playback Multiple Times command.

This command is not available if a macro record has not been recorded or loaded.



Macro Playback Multiple Times (Macro menu)

The Macro Playback Multiple Times command allows a macro that has been recorded with the Macro 
Record command to be replayed multiple times. A dialog box is presented that prompts the user for a 
number between 1 and 100000 that specifies the number of times the macro should be replayed. To 
replay the macro a single time use the Macro Playback command.

This command is not available if a macro record has not been recorded or loaded.



Word Wrap command (Tab Configuration Page)

Use this command to automatically wrap words to the next line at the horizontal edge of the active 
window, or at a specified column.

There are three selectable modes of operation for word wrap:

Wrap at window boundary, without inserting a hard return.
Wrap at a specified column number without inserting a hard return.
Wrap at a specified column number and insert a hard return.

With this option, an additional option specifiies if the file should be automatically wrapped 
on input.    If selected, the file is wrapped on input, otheriwse text is only wrapped as it is 
modified.

If the option to wrap at a specified column AND insert a hard return is made, the file is automatically 
modified to wrap at the column and insert appropriate hard returns.

Additionally, the Reformat Paragraph paragraph feature may be used to wrap a paragraph to the specified 
column number.

If the editor active window is in HEX mode, this command is not available.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of UltraEdit.



Setting and Moving to Bookmarks (View menu)

UltraEdit allows you to set a "bookmark" to mark a position in a file. Once a bookmark has been set at a 
line, you may use menu or keyboard commands to move to that line. 

 To set a bookmark:

1. Move the cursor to the line where you want to set a bookmark.
2. From the View menu, choose Toggle Bookmark.

Shortcut
Keys: CTRL+F2

 To move to the next bookmark after the insertion point, choose Next Bookmark from the View menu.

Shortcut
Keys: F2



Automatic Line Indentation (General Configuration Page)

UltraEdit provides automatic line indentation.    When automatic line indentation is enable, UltraEdit 
automatically indents a line to match the indentation of the previous line. The indentation is performed by 
inserting spaces into the document.

This option is only active in INSERT mode, not in OVERSTRIKE mode.



Delete Active File command (File menu)

Use this command to close the active document and delete its associated file from the disk. This 
command prompts the user to ensure the file should really be deleted. If the file is deleted from the disk, it 
is no longer available. USE THIS COMMAND WITH CARE.



Hex Mode Editing (Edit menu)

The HEX Edit command selects the editing mode for the active window. The mode is toggled between 
Hexadecimal (HEX) and ASCII. The ASCII mode of editing is typically used for any ASCII (text) based 
files. In the ASCII mode, UltraEdit allows normal operation of all functions and allows any characters to be 
typed.

The HEX mode of editing is typically used for non ASCII files, or binary files. These files typically contain 
non-printable characters, and are not text files.

The following restrictions apply when HEX mode is selected:

Insert mode is not supported.

When the HEX mode of editing is selected for a given window, UltraEdit splits the screen area into three 
areas as shown:

File Offset: Hexadecimal Representation ; ASCII Representation
000000h: 30 31 32 33 34 35 36 37 38 39 30 31 32 33 34 35 ;123456789012345 

The file offset area shows the current byte offset of the character at the beginning of the line to form the 
beginning of the file.

The hexadecimal representation, shows the hexadecimal value of each file byte as a two character field, 
separated from the next byte by a space (' ').

The ASCII representation provides the view of printable characters. Non printable characters are shown 
with a period character ('.').

Editing may be performed in the ASCII area, or the HEX area. Positioning from one area to the other is 
performed by clicking the left mouse button in the appropriate area or by pressing the TAB key. The TAB 
key switches the cursor between the ASCII and HEX area and maintains the character offset in the file.    
In the HEX area, the only valid characters are, 0-9, A-F, and a-f. All other characters are invalid and are 
ignored. In the ASCII area, any printable character is valid, and will be accepted with the exception of 
<CR> and ENTER.

Editing in either the ASCII are or the HEX area automatically updates the other area after each valid 
character is typed.

All modifications are performed in OVERSTRIKE mode.
To insert or delete characters in HEX mode, use the HEX Insert/Delete selection from the Edit menu.

Cut, copy and paste are supported in HEX mode.

Shortcut
Keys: CTRL+H



Insert/Overstrike Modes

UltraEdit allows editing in both insert and over strike modes. The mode of operation is indicated in the 
status bar at the bottom of the UltraEdit window. The insert/overstrike mode is changed with    the INSERT 
key. The mode is toggled when the INSERT key is pressed.

If insert mode is selected, the second area of the status bar is clear, if overstrike mode is selected, the 
second area of the status bar shows 'OVR'.

Insert mode causes a key to be inserted into the document at the position of the cursor. Overstrike mode 
causes the character immediately to the right of the cursor to be overwritten by the new character.

If the editor active window is in HEX mode, the active window is always in overstrike mode.    To insert text 
in HEX mode, use the HEX Insert/Delete selection from the Edit menu.
 



Tab Settings (Tab Configuration Page)

UltraEdit allows for selection of TAB stops and for TAB characters to be replaced by spaces automatically 
while editing. The tab settings menu item under the edit menu displays a dialog that has two items that 
may be modified.

The first item, if checked instructs UltraEdit to replace TAB characters with spaces.    If this selection is 
made, the second item allows selection of the number of spaces to use.

The second item specifies the TAB stops, or the number of spaces to use in place of a TAB character.

If the option to replace TABs with spaces is chosen,      UltraEdit inserts spaces in place of TABS but 
maintains the TAB stop spacing using the number of spaces specified.

UltraEdit does not replace existing TAB characters that may exist within the document.

Word-Wrap settings.



Set Font (View menu)

The Set Font menu item presents the Choose Font dialog box that allows selection of different fonts and 
font sizes.    The selection made will apply to the screen fonts and will also be applied to the printer font if 
the Mirror Display Font menu item is checked on the View Menu.    If this item is not checked,    the printer 
fonts have been selected independently from the screen fonts.

Font selections may be reset to default values by selecting the Reset Fonts menu item.

Note:    If the printer does not support the font,    Windows automatically adjusts to the closest font.



Set Printer Font (View menu)

The Set Printer Font menu item presents the Choose Font dialog box that allows selection of different 
fonts and font sizes for use by the printer.    The selection made will apply only to the printer fonts.    
Selection of the printer fonts unchecks the Mirror Display Font menu item on the View Menu.    Only fonts 
applicable to the printer will be available.

Font selections may be reset to default values by selecting the Reset Fonts menu item.



Mirror Display Font (View menu)

The Mirror Display Font menu item instructs UltraEdit to use the font that is selected for the screen on the 
printer.    This overrides any font selection already made for the printer with the Set Printer Font menu 
item. 



Reset Fonts (Default) (View menu)

The Reset Font menu item instructs UltraEdit to reset user selections of the screen and printer fonts to 
the default settings.    Any user selections of the screen fonts made with the Set Font menu item or printer 
fonts made with the Set Printer Font menu item will be lost.



Add Indents (Format menu)

The Add Indents menu item presents a dialog that allows the user to specify the number of spaces to add 
at the beginning of each of the selected (highlighted) lines.    UltraEdit starts adding the specified number 
of spaces to each line beginning with the first highlighted line and ending with the last line that has at 
least one character selected (highlighted).

The Indents will be added to all lines stated above,    irrespective to and indentations that may already 
exist.

To remove indentations, use the Remove Indents menu item on the Format Menu.



Remove Indents (Format menu)

The Remove Indents menu item presents a dialog that allows the user to specify the number of spaces or 
tabs remove from the beginning of each of the selected (highlighted) lines.    If the checkbox specifying 
removal of all indents is checked, UltraEdit will remove ALL indentation at the beginning of the selected 
lines.    UltraEdit starts removing the indents beginning with the first highlighted line and ending with the 
last line that has at least one character selected (highlighted).

If no indentation is found at the beginning of a selected line, no changes are made to that line.

To add indentations, use the Add Indents menu item on the Format Menu.



Hex Insert/Delete (Edit menu)

The HEX Insert/Delete command allows the insertion or removal of characters at the current cursor 
position while in the HEX mode.    This command presents a dialog that allows selection to insert or delete 
characters and requires the number of characters that are to be inserted or deleted to be specified.

If insert is selected, UltraEdit will insert the specified number of characters in the file and initialize them to 
a hexadecimal value of 20 (ASCII space).    The characters may them be modified as required.

If delete is selected, the specified number of characters will be removed from the file beginning at the 
cursor position.

Shortcut
Keys: CTRL+D



Disable Line numbers (General Configuration Page)

The Disable Line Numbers option allows the line number display in the status bar to be disabled.    Under 
normal circumstances this option should be left unchecked.    For very large files,    file positioning may be 
slowed down while UltraEdit establishes the line number.    In this case the line numbers may be disabled.

If the option is checked, line numbsers are disabled, if unchecked line numbers are enabled.



Drag and Drop

UltraEdit supports dragging and dropping files from the File Manager into an open session of UltraEdit.    
Files may be selected from the File Manager (multiple files may be selected) and dragged into the 
UltraEdit window.    If the mouse button is released with the mouse over UltraEdit's window the files 
selected will automatically be opened for editing with UltraEdit.



Command Line Parameters

UltraEdit supports command line parameters specifying files to be opened.    UltraEdit allows multiple files 
to be specified in the command line.    Each of the files specified will be opened when UltraEdit starts up. 
The filenames on the command line should be separated with a space (' ').    For long file names, they 
should be enclosed in quotes "".

To specify the line and column number at which to position the cursor when the file is opened, the line 
number and column number should follow the file name immediately separated from the filename by a '/' 
character follows:

filename/5/2 This opens the file with the cursor positioned at line 5, column 2.    The line 
number may be specified without specifying the column number.

The separator character '/' was a comma in previous releases, however as this is a valid character for 
filenames it has been changed.    If it is preferred to use the comma, or another character the following 
line may be added to the INI file:

LineColumnChar= ,

where the comma maybe any character except colon ':', however UltraEdit will not be able to open a file 
that contains this character.

UltraEdit accepts a '/P' or '/p' on the command line.    This instructs UltraEdit to print the files that appear 
on the command line automatically and to exit when the files have been printed.

UltraEdit allows macros to be automatically invoked from the command line with the following syntax 
added to the command line:

/M,E,5="full path of macro file/macro name"

The /M specifies the macro command
The ,E specifies that after execution of the macro, the file should be saved and the editor exit, this 
is an optional parameter.
The ,5 specifies the number of times the macro should run.    This is an optional parameter, and if 
not present the macro will run once if a file is loaded on the command line.    If a file is not 
specified on the command line the macro will not run unless the number of times is specified.
The macro file name is specified in    quotes.    Optionally, the name may include a forward slash 
(/) followed by the name of the macro if the file contains more than one macro.    If a macro name 
is not specified, the first macro in the file will be used.



Page Setup (File menu)

The Page Setup menu item presents a dialog allowing the user to set up page headers, footers and 
margins for printing.    The page header, if setup, is printed at the top of every page.    The page footer, if 
setup, is printed at the bottom of every page.    If a page footer or header is setup, a single line is printed 
across the page between the header or footer and the text to be printed.

The header or footer may be disabled by selecting the appropriate check box.

The page header and footer may include text defined by the user, and additionally special characters to 
allow the filename, and page numbers to be printed in the header or footer.

The special characters are:

&f This is replaced in the header or footer with the filename.
&p This is replaced in the header or footer with the page number.

Additionally,    the header or footer may include the file date and time or system date and time.    Two radio 
buttons allow the selection of either the file date, or the system date to be included in the header or footer. 
The radio buttons select the source of the date and time,    additional special characters used in the 
header or footer specify if the date and time are to be printed and what format is used.

The characters used to specify the time and date format are shown below,    the absence of any of these 
characters result in the time and date not being printed.

The formatting codes date and time    are listed below:

Format Description
%a Abbreviated weekday name
%A Full weekday name
%b Abbreviated month name
%B Full month name
%c Date and time representation appropriate for the locale
%d Day of the month as a decimal number (01-31)
%H Hour in 24-hour format (00-23)
%I Hour in 12-hour format (01-12)
%j Day of the year as a decimal number (001-366)
%m Month as a decimal number (01-12)
%M Minute as a decimal number (00-59)
%p Current locale's AM/PM indicator for a 12-hour clock
%S Second as a decimal number (00-59)
%U Week of the year as a decimal number, with Sunday as the first day of the week (00-51)
%w Weekday as a decimal number (0-6; Sunday is 0)
%W Week of the year as a decimal number, with Monday as the first day of the week (00-51)
%x Date representation for current locale
%X Time representation for current locale
%y Year without the century as a decimal number (00-99)
%Y Year with the century as a decimal number
%Z Time zone name or abbreviation; no characters if time zone is unknown
%% Percent sign

Examples:



Date is July, 4th 1994.    Time is 9:00pm
"%X , %x" prints "21:00 , 07/04/94"

Date is July, 4th 1994.    Time is 9:00pm
"%c" prints 07/04/94 21:00

Date is Jan, 10th 1991.    Time is 5:00am
"%A, %B %d, %Y %I:%M%p" prints Tuesday, January 10, 1991    05:00:am

Page Margins
The page margins may be set up in either inches or millimeters (mm).    Each margin, top, bottom, left and 
right may be set independently.    The margins are applied before the headers and footers are generated. 
If the printer is set up to have a minimum margin that is greater than the margin selected in UltraEdit the 
printer margin will be in effect.

Page Break Character
The page break character may be set to any ASCII character.    The page break character defaults to a 
form-feed character ,12 (0C HEX).    This character may be changed if required but should not be set to 
any printable character as a page break will be inserted on every occurrence of this character when 
printing occurs.    It may be desirable to change this character if the font being used does not allow the 
page break character to be seen.



Goto Line/Page (Edit menu)

The Goto menu item presents a dialog that allows the user to specify the line or page break at which the 
cursor should be positioned.    The cursor is positioned at the line specified and the line is scrolled into 
view.    If the line number is greater than the number of lines in the file, the cursor is positioned at the end 
of the file.

When Page Break is specified, the cursor is positioned at the line with the specified page break character.

In HEX mode the goto dialog allows the user to select the offset into the file at which the cursor should be 
positioned.    If the offset is greater than the file size, the cursor is positioned at the end of the file.

Shortcut
Keys: CTRL+G



Insert Page Break (Edit menu)

The Insert Page Break menu item inserts a page break character at the current cursor position.    The 
page break character can be configured in the Page Setup dialog.

When the document is printed,    the page break character is replaced with a page break.    Printing 
continues on the next page following a page break character.



Generate Backup File (General Configuration Page)

The Generate Backup File menu item determines if UltraEdit will copy the original file to a backup file 
when changes are saved.    If this item is checked UltraEdit will copy the original file to a file with the same 
name and a ".BAK" extension when the file is saved.    If this item is not checked, a backup file will not be 
generated.



Keyboard Commands

UltraEdit allows the use of keyboard commands for a number of commonly used features.    The keyboard 
commands are listed below:

F1 Help Show UltraEdit help
Shift+F1 Context Help Invoke the context help command and cursor.
Ctrl+N File New Create a new document file
Ctrl+O File Open Open an existing document file
Ctrl+F4 File Close Close an existing document file
Ctrl+S File Save Save the active document
Ctrl+P File Print Print the active document
Ctrl+X Edit Cut Cut text from the document into the clipboard
Ctrl+C Edit Copy Copy text from the document into the clipboard
Ctrl+V Edit Paste Paste text from the clipboard into the active 

document
Ctrl+Z Edit Undo Undo the last action if possible
Ctrl+A Edit Redo Reverse the last Undo action if possible
Alt+F3 or
Ctrl+F

Edit Find Find a character string

F3 Edit Find Next Repeat last find
Ctrl+B Edit Match Brace Find matching brace (,[,{ or },],)
Ctrl+R Edit Replace Find and replace a character string with another
Ctrl+G Edit Goto Goto the specified line (or HEX address)
Ctrl+K Edit Reformat Paragraph Reformat the current paragraph or selected text
Ctrl+F5 Format To Lower Convert selected text to lower case
ALT+F5 Format To Upper Convert selected text to Upper case
F5 Format Capitalize Capitalize first character of each word in selected text
Shift+F5 Format Invert 

CaseHID_INVERTCASE
Invert case of all characters in selected text

Ctrl+K Edit Spell Check Invoke the spelling checker
ALT+C Column Mode Toggle column/block mode on and off
Ctrl+Backspace Delete previous word Delete the word preceding the cursor
Ctrl+I Insert Literal Character Insert a literal character at the cursor position
INS Insert/Overstrike Mode Toggle between Insert and Overstrike mode
Ctrl+H HEX Edit Toggle HEX editing mode
Ctrl+D HEX Insert/Delete Insert or delete characters in HEX editing mode
Ctrl+F2 Set Bookmark Toggle bookmark on and off
F2 Goto Bookmark Goto next bookmark
Ctrl+M Macro Play Replay a macro
Ctrl+L Macro Play Multiple Times Replay a macro the specified number of times
Ctrl+F6 Next Window Make the next document window active
Ctrl+Shift+F6 Previous Window Make the previous document window active
Alt+F4 Exit UltraEdit Exit UltraEdit
Ctrl+Shift+A Inserts ä character
Ctrl+Shift+A Inserts Ä character

(Caps Lock on)
Ctrl+Shift+O Inserts ö character
Ctrl+Shift+O Inserts Ö character

(Caps Lock on)
Ctrl+Shift+U Inserts ü character
Ctrl+Shift+U Inserts Ü character

(Caps Lock on)
Ctrl+Shift+S Inserts ß character



Ctrl+Shift+S Inserts ß character
(Caps Lock on)



UNIX/MAC to DOS (File menu)

Use this command to correct the end of line characters for display in UltraEdit and other text editors.

Some documents generated from UNIX based systems (and some other systems) do not terminate each 
line with a carriage return and linefeed.    UltraEdit requires all lines to be terminated with a carriage return 
and linefeed character. 

This command searches the file for all carriage return and linefeed characters.    If a carriage return 
character is found without an accompanying linefeed character, a linefeed character is added.    If a 
linefeed character is found without a preceding carriage return character a carriage return character is 
inserted.    If a linefeed is found preceding a carriage return the characters are reversed.

To convert a file to UNIX format, use the DOS to UNIX command.
To convert a file to MAC format, use the DOS to MAC command.



To Upper Case (Format menu)

This command changes all selected text to upper case.    There is no limit on the amount of text that may 
be selected.

Shortcut
Keys: ALT+F5



Invert Case (Format menu)

This command inverts the case of all selected text.    There is no limit on the amount of text that may be 
selected.

Shortcut
Keys: SHIFT+F5



To Lower Case (Format menu)

This command changes all selected text to lower case.    There is no limit on the amount of text that may 
be selected.

Shortcut
Keys: CTRL+F5



Capitalize (Format menu)

This command changes the first letter of all words in the selected text to upper case and the remaining 
letters to lower case.    There is no limit on the amount of text that may be selected.

Shortcut
Keys: F5



Right Mouse Button Commands

UltraEdit allows the right mouse button to display a pop-up menu.

If the right mouse button is clicked while in a document window, the Edit Menu is displayed at the position 
of the mouse click.    If text is selected when the right mouse button is pressed, a new menu item Open 
File Highlighted is added to the top of the pop-up menu and if selected the file is opened if it exists.

If the right mouse button is clicked while in the UltraEdit main window and outside of a document window, 
the File Menu is displayed at the position of the mouse click.



Insert File (File menu)

Use this command to insert an existing document (file) into the active document.

This command presents a dialog allowing selection of the file to insert.    The complete contents of the 
selected file is inserted in the active document at the cursor position.



Convert CR/LF's to Wrap (Format menu)

Use this command to remove the CR/LF (carriage return/line feed) characters from the file allowing the 
text to be Word Wrapped by UltraEdit.    This feature removes all CR/LF characters for text that is 
selected.    If no text is selected this function has no effect.

To remove all CR/LF characters from the file select the complete file.    To do this, position the cursor at 
the beginning of the file and press CTRL+SHIFT+END at the same time.

To add CR/LF (carriage return/line feed) characters to the file use the 
Convert Wrap to CR/LF's command.



Convert Wrap to CR/LF's (Format menu)

Use this command to Word Wrap the text based on either the width of the display window or a specified 
column number and write CR/LF (carriage return/line feed) characters to the file.    If a space is found at 
the position of the wrap a single space is removed.    This allows the document to be saved as viewed in 
the word wrap state with CR/LF characters inserted at the end of each word wrapped line.

When this item is selected, a dialog box is displayed allowing selection of the wrap parameters.    By 
default, the text will be wrapped based on the current view.    That is to say, the text will be wrapped at the 
window boundary as shown on the screen.    This dialog allows selection of a column number at which the 
text should be wrapped.    In this case the text will be wrapped at the specified column or at the preceding 
word boundary on the line. 

This feature works on the complete file if no text is selected.    If a selection is made, the feature only 
converts the selected area.

To remove CR/LF (carriage return/line feed) characters from the file use the Convert CR/LF's to Wrap 
command.

:



Multiple Instances (General Configuration Page)

The Multiple Instances menu item determines if UltraEdit opens another instance of UltraEdit if it is 
invoked when a copy is already active.    If this option is enabled, a new instance is opened each time 
EditPro is invoked.    If this option is not enabled, only a single instance of UltraEdit is opened, and any 
additional requests result in the first instance becoming active with the new file loaded in addition to any 
files already open.



Save All command (File menu)

Use this command to save all modified documents to its current name and directory.    When you save a 
document for the first time, UltraEdit displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the Save 
As command.



Column Mode (Column menu)

This command changes the operation of the editor for selecting text.    When column mode is selected 
highlighted text is based on the character column position of the first character selected to the column of 
the last character of text selected.    Text selected in this mode does not automatically include all text 
between the start and end position, but includes all text in the columns between the first and last 
character selected.

Column mode editing is sometimes referred to as block mode editing as the act of selecting text forms a 
rectangle.

Cut, Copy and Paste work with the selected text.

Column mode editing requires the Word Wrap be turned off and a fixed pitch font be selected.

When column mode is enabled, additional column features are enabled; Insert/Fill Columns, Delete 
Columns, Cut Columns and Insert Number.

Shortcut
Keys: ALT+C



Insert/Fill Columns (Column menu)

This command presents a dialog that allows a text string to be entered.    This text will be inserted into 
every line that is selected, or if no selection is made it will be inserted into every row starting at the current 
cursor position and proceeding to the last row of the file.    The text string will be inserted into every row at 
the column position indicated by the cursor when this command is invoked.    If text does not exist at this 
column in any row, spaces ' '    will be added to pad the row allowing the text to be inserted correctly.

If at the invocation of this command, text is highlighted, the columns indicated by the highlighted text will 
be replaced with the specified text.



Delete Columns (Column menu)

This command presents a dialog that allows the number of columns to be deleted to be specified.    The 
columns will be deleted from every line that is selected, or if no selection is made they will be deleted 
from the file from every row starting at the current cursor position and proceeding to the last row of the 
file.    If a value of zero '0' is entered, columns will be deleted based on the highlighted text when this 
command is invoked.    This command does not save the deleted text in the clipboard.



Cut Columns (Column menu)

This command presents a dialog that allows the number of columns to be cut to be specified. The 
columns will be removed from every line that is selected, or if no selection is made they will be removed 
from the file from every row starting at the current cursor position and proceeding to the last row of the 
file.    If a value of zero '0' is entered, columns will be removed based on the highlighted text when this 
command is invoked.    This command saves the removed text in the clipboard.



Insert Number (Column menu)

This command allows a sequential number to be inserted into every line selected, or if no lines are 
selected, into every line at the column position indicated by the cursor.    This command presents a dialog 
that allows the initial value to be entered and the increment for each line.    This provides an easy method 
to add line numbers into a text file.

If any text is highlighted at the invocation of this command, the highlighted text will be replaced by the 
inserted line numbers.    The spacing required for the line numbers is calculated automatically based on 
the number of lines that will have a number inserted, the initial value and the increment.    All numbers 
must be positive integers.



Find In Files command (Edit menu)

This command displays a dialog box for searching for a text string in files on a disk.    You can specify the 
string to search for and the files to search.    Valid filenames may include wildcard characters, so to search 
all text files with the extension "*.txt" you may specify "path\*.txt" where path is the drive and full directory 
path to the files.    You may also select to search files in sub directories.

The following search options exist:

Match Case
By default, the search will not be case sensitive. The option to make the search case sensitive is 
given.

Search Sub directories
By default, only files specified in the specified directory are searched.    This instructs the search to 
search all sub directories of the specified directory.

Regular Expressions:
Symbol Function

? Matches any single character except newline
* Matches any number of occurrences of any character except 

newline
^p Matches a newline(paragraph)
^t Matches a tab character
[ ] Matches any single character, or range in the brackets
^ Overrides the any following regular expression character

Examples:
m?n matches "man", "men", "min" but not "moon".

t*t matches "test", "tonight" and "tea time" (the "tea t" portion) but not "tea
time" (newline between "tea " and "time").

[aeiou] matches every lowercase vowel
[,.?] matches a literal ",", "." or "?".
[0-9, a-z] matches any digit, or lowercase letter
[~0-9] matches any character except a digit (~ means NOT the following)

When the find is executed, a new file window is opened (if it does not already exist) with the title "Find 
Results".    This windows is updated with each occurrence of the found string and the line number of the 
file in which it was found.    This window may be saved, printed, or edited in the same manner as any file.

Successive finds update an existing "Find Results" window if it already exists, or creates a new window if 
it does not.    If the window already exists, results are appended to the end.



General Configuration Page

The general options page has the following selections:

Auto Indent Toggles the state of automatic line indentation for UltraEdit.
Allow Positioning 
Beyond Line End

This option allows the cursor to be positioned beyond the end text in a line.

Generate Backup File If checked, generate a backup file when document is saved.
Use Large Icons On 
Tool Bar

If checked, large icons are used on the tool bar.    This option is only read at 
startup.

Multiple Instances If checked, allow multiple instances of UltraEdit.
Disable Line Numbers Disables line number display. This improves speed on large files.
Open File Without 
Temp File

Open file without creating temporary file (all changes are permanent).

Auto Detect Unix Files This option instructs UltraEdit to automatically detect Unix files when opened 
and ask if they should be converted.

Auto Convert Unix FilesThis option instructs UltraEdit to automatically detect and convert Unix files 
when opened.

Default to Read Only This option determines if the file is opened as Read-Only by default.
Macro Default DirectorySet the default directory for loading and saving macros.
Spelling 
Checker/Template User 
Directory

Set the directory for the user portion of the spelling dictionary and template 
storage.

Reload Open Files on 
Startup

Remember the files that were open from last session and reload them on start 
up.

Left Delimiters for 
Ctrl+Dbl Click

Configure delimiter characters for text selection with Ctrl+Mouse Left Button 
Double Click.

Right Delimiters for 
Ctrl+Dbl Click

Configure delimiter characters for text selection with Ctrl+Mouse Left Button 
Double Click.

Number of Recent files Set the number of recent files that appears on the file menu for quick opening of 
file.



File Type Configuration Page

This page allows the list of file types that appear in the File Open and File Save As dialog boxes to be 
configured.    Up to 10 file types may be configured.    These file types will be shown in the file operation 
dialog boxes in the same order they are shown on this page.

Each file type configured consists of a file name and file description.    The file name may (and probably 
does) include wildcard characters and may include multiple file extensions each separated by a 
semicolon    ";"(i.e. "*.c;*.cpp").    The file description is a text field describing the file types.

This dialog also provides a DEFAULT button that resets the file types to the initial settings.



DOS to UNIX (File menu)

Use this command to convert the file to a UNIX format.    This will replace the carriage return and line feed 
combinations to a line feed only.

To convert a file from UNIX or MAC format, use the UNIX/MAC to DOS command.



DOS to MAC (File menu)

Use this command to convert the file to a Macintosh format.    This will replace the carriage return and line 
feed combinations to a carriage return only.

To convert a file from UNIX or MAC format, use the UNIX/MAC to DOS command.



OEM to ANSI (Format menu)

Use this command to convert a file that uses the OEM character set (usually DOS generated text files) to 
the ANSI (Windows) character set.

To convert a file from ANSI to OEM, use the ANSI to OEM command.



ANSI to OEM (Format menu)

Use this command to convert a file that uses the ANSI (Windows) character set to the OEM (DOS) 
character set.

To convert a file from OEM to ANSI, use the OEM to ANSI command.



Syntax Highlighting Configuration Page

Syntax hightlighting is the ability to recognize predefined words and display them in a different color(s).    
This is particularly useful for programmers, and can also be useful to other users who may want certain 
words in a document to show up in a different color.

UltraEdit provides support for six languages or word sets that may be recognized.    The first three word 
sets may be configured to have a different color for the following groups of words:

Normal Text (Words that are not recognized)
Words that appear in a comment line
Upto three groups of different recognized words

The last three languages use the share the color settings of the third language.
 
Each color may be changed by clicking on the colored box beside the text description.    When clicked, a 
dialog box will appear that allows the new color to be selected.

The predefined words may be configured by the user as follows:

UltraEdit reads a configuration file (the default file is "WORDFILE.TXT"), to configure the syntax 
highlighting.    This file is read each time the editor starts up.    The syntax for this file is as follows:

The word set, or language is specified by a /Ln where n has a value of 1 to 6.    This must be at the 
beginning of the line.    The comment characters used for line comments is specified by the string "Line 
Comment = "    followed by the comment characters.    Two characters are allowed, if there is only one 
then it must be followed by a space.

Additionally the characters used for block comments may also be configured (i.e. /* … */ for C).    These 
are in the form "Block Comment On = " and "Block Comment Off =" followed by up to two characters that 
define the comment designators.    For compatibility with previous releases, the /* and */ are used for file 
types that have .C as one of the extensions.    This may be overridden.

The file extensions that are applicable for this language are specified by the string "File Extensions = " 
and each extension is separated by a space.    Color codes may be specified by adding a line with /Cn at 
the beginning of the line, where n is the color index of 1 to 3.

All information specified remains in effect until overridden with new command information.

The following example specifies the first language to be used with files with the extensions 'C', 'CPP', 'H' 
or 'HPP'.    The color used for the words is the first selectable color and the comment characters are //.

/L1 Line Comment = // Block Comment On = /* Block Comment Off = */ File Extensions = CPP C H HPP
/C1
auto
break
case char const continue chr$
default do double

If the language is not case sensitive, the keyword Nocase may be added to the command line i.e.:

/L1 Line Comment = // Nocase File Extensions = CPP C H HPP

When using many programming languages, characters in single quotes and double quotes are treated as 



literal strings, and word and comment recognition should be ignored.    This is the default behavior for 
UltraEdit.    There are some languages, (i.e. HTML and others) where this behavior is undesirable.    To 
facilitate such languages the keyword "Noquote" may be added to the command line to override the 
default behavior i.e.:

/L1 Noquote File Extensions = HTM

Note that ALL words starting with the same character MUST be on the same line.    If the language is case 
sensitive, the letter 'A' is different from 'a' and so words starting with 'A' MUST be on a different line from 
words starting with 'a'.    If the language is case insensitive words starting with the letter 'A' must be on the 
same line as words starting with the letter 'a'.

HTML Specific

HTML is considerably different from other languages, and to better facilitate the use of UltraEdit for editing 
HTML files the "HTML_LANG" keyword was added.    When this keyword is present the special characters 
'<' and '/' may be placed in front any keyword as desired without all keywords with the special characters 
all having to be on the same line (unless they all begin with the same letter).

Below is an example portion of a word file for HTML:

/L3 Line Comment = // HTML_LANG Block Comment On = <% Block Comment Off = %> File Extensions = HTM HTML
/C1
<A </A> <ADDRESS> </ADDRESS> <APPLET </APPLET>
<B> </B> <BASE <BASEFONT <BGSOUND <BIG> </BIG> <BLINK> </BLINK> <BLOCKQUOTE> </BLOCKQUOTE> 
<CAPTION> </CAPTION> <CENTER> </CENTER> <CITE> </CITE> <CODE> </CODE>

Additional enhancements for HTML will be added in the future.

Delimiters

UltraEdit has built in delimiters that are used to determine when a new word starts, and when a word 
finishes so that it may be matched against the set of words for a given language.    With the exception of 
the '<'' and '>' characters in HTML a character that is a delimiter may not also be part of a word. i.e. you 
can not say the @ symbol is to be considered part of a word, and it is a delimiter between words.    
(Future enhancements may allow this).

With release 4.1 and later, UltraEdit allows the delimiter characters to be configurable by the user.    For 
compatibility, the existing delimiters are retained if the user does not specify the delimiters for a given 
language.    Each language may have it's own set of delimiters.    It is not necessary to configure the 
delimiters for languages if you are using the defaults.

To specify the delimiters, add a NEW line similar to the following to your wordfile:

/Delimiters = ~!@$%^&*()_-+=|\/{}[]:;"'<> ,.?/
Note that the Delimiters should include a space character if you want it to be considered a delimiter.    The 
line must begin with "Delimiters =".

This file may be modified by the user. 



Spelling Checker (Edit Menu)

UltraEdit incorporates a 100,000+ word spelling checker.    The spelling checker is invoked from the Edit 
Menu and will check the complete file if text is not selected, or if text is selected it will check the selected 
text.

The spelling checker will suggest a word for words that are not found in the dictionary, and will allow the 
user to save new words in the user dictionary.    The user dictionary directory may be set in the General 
Options configuration page.



Send Mail command (File menu)

Use this command to send the active file as a MAIL attachment.    The file, and all changes are sent.    
This feature is only supported on systems that have MS-MAIL installed.



Reformat Paragraph command (Format menu)

Use this command to format the current paragraph (or selected text) to the specified column number 
boundary.    The column number is specified in the Advanced General Configuration page.    A paragraph 
is determined as having two hard returns in succession (i.e. a blank line).

All hard returns are removed for the paragraph, and the paragraph is reformatted to the appropriate 
column boundary.



Display/Modify Templates command (Advanced menu)

Use this command to display the dialog for editing the templates.    A template is a pre-definned text that 
may be recalled automatically at a later time and inserted into a file.

Up to 20 templates may be defined.    Each template may be recalled at a later time using hot keys Alt+0 
through Alt+9, and Shift+Alt+0 through Shift+Alt+9, or with the Insert Template dialog.

The templates are stored in a file in the default directory, or the directory specified in the General Options 
configuration page.

A template may contain special text strings that are translated at the time the template is recalled.    These 
special strings are:

[DATE_DMY] Is translated into the current date with the format DAY/MONTH/YEAR.
[DATE_MDY] Is translated into the current date with the format MONTH/DAY/YEAR.
[DATE_TEXT] Is translated into the current date with the date diaplayed as text.
[TIME] Is translated into the current time IN 24 HOUR FORMAT.
^ This indicates the position at which to place the cursor after the template has 
been inserted.



Insert Templates command (Advanced menu)

Use this command to insert a template.    It presents a dialog, allowing you to enter the number of the 
template to insert, 0 throught 9.

Optionally, the hot keys Alt+0 through Alt+9 may be used instead of this menu command.



Large file handling

UltraEdit allows editing of very large files.    This is accomplished with relatively small amounts of memory 
being used.    UltraEdit is a disk based editor, and only loads a small portion of the file into memory at one 
time.

Normally, UltraEdit copies a file that is being edited to a temporary file, and at the end of the editing 
session deletes the file, after copying back to the appropriate original file.

To speed up editing of very large files, the    General Options configuration page allows you to specify 
editing without using temporary files.    This removes the time necessary to copy the file to a temporary 
file.    When editing files of many megabytes this can be an advantage.

WARNING - If this option is selected, all changes are permanent!

Additionally, the Disable Line Number option improves the performance when navigating around large 
files as less disk access are required to track the line numbers.



DOS Command (Advanced menu)

This command allows a DOS command to be run from within UltraEdit and the results of the command 
are captured and automatically displayed with UltraEdit at the completion of the command.

A dialog box is presented that allows the command to be specified (with a browse button) and the working 
directory to be specified (working directory only supported with UltraEdit-32).

The command line specified should be the full path of the file to be executed unless it is a system 
command (such as DIR), or it is in the Windows directory, or the Windows System directory.

The working directory should be the full path of the working directory, or left blank if not required.

In order to allow maximum flexibility of programs to be run, a special command line sequence is permitted 
that will cause the active file name to be inserted into the command line and passed to the program to be 
executed.    For example:

You set up a command to run a compiler and you want to invoke the compiler with the file you are 
currently editing.    If you change files you want the compiler to be invoked with the new file.    The 
compiler is c:\comp\compiler.

Specify the following command in the dialog box:
c:\comp\compiler %F

When the command is executed, the %F will be replaced by the full directory path, filename and 
extension of the active window,    The file will be saved before the command is executed.

The following commands may be used to pass a portion of the full qualified filename:

%P Path only ("C:\project\test\")
%N fileName only ("test")
%E Extension only (".c")

%P%N%E is equal to %F which is ("C:\project\test\test.c") in the example above.

The output from the command will be captured and displayed in a window when the command 
has completed.

As the output from a DOS program is sometimes buffered by the operating system, this process may not 
work correctly with a program that requires interaction while it is executing, the prompts may not appear 
on the screen at the correct time and the user may wonder why there is no activity.

As the output will always be captured.    If the program generates no console screen output the captured 
output may be empty and UltraEdit will show an empty window.

The Last DOS Command repeats the last command specified with the DOS command dialog without 
presenting the dialog box.



Run Windows Program (Advanced menu)

This command allows a Windows program to be executed from within UltraEdit.    The output is not 
captured.

A dialog box is presented that allows the command to be specified (with a browse button) and the working 
directory to be specified (working directory only supported with UltraEdit-32).

The command line specified should be the full path of the file to be executed, unless it is in the Windows 
directory, or the Windows System directory.

The working directory should be the full path of the working directory, or left blank if not required.

In order to allow maximum flexibility of programs to be run, a special command line sequence is permitted 
that will cause the active file name to be inserted into the command line and passed to the program to be 
executed.    For example:

You set up a command to run a compiler and you want to invoke the compiler with the file you are 
currently editing.    If you change files you want the compiler to be invoked with the new file.    The 
compiler is c:\comp\compiler.

Specify the following command in the dialog box:
c:\comp\compiler %F

When the command is executed, the %F will be replaced by the filename of the active window,    
The file will be saved before the command is executed.

To run a DOS program use the DOS Command.



Insert Literal Character (Keyboard Command)

This command allows a literal character (such as Control C) to be inserted into the file.    Pressing Ctrl+I 
tells UltraEdit that the next character is to be inserted directly into the file without any translation.

This is useful for inserting control codes that may be needed by printers or other devices.

Example:
Ctrl+I followed by Ctrl+C inserts a Control C character into the file
Ctrl+I followed by ESC inserts an escape character into the file

Shortcut
Keys: Ctrl+I



Match Brace (Edit menu)

This command searches forward in the file from the cursor position to find an open or close brace.    If an 
open brace is found, the search continues in a forward direction until a matching close brace is found at 
the same nest level.    If the first brace found is a close brace, the search is performed in the reverse 
direction until a matching open brace is found at the same nest level.

When the matching brace is found, all the text between and including the two braces is highlighted.

An open brace is (, [, or {.    A close brace is ), ] and }.

Shortcut
Keys: Ctrl+B



Read Only Command (Edit menu)

The Read Only command toggles the state of the read only status of the file.    If the read only status is 
set the file can not be modified.    If the file has already been modified the modifications are maintained 
and the file may be saved.

The default behavior of the read only status may be configured in the General Configuration Page.    This 
determines if the file is read only when it is opened.



Select Line (Edit menu)

The select line command highlights the line in which the cursor is positioned.    The end of line characters 
are also highlighted.    This allows an easy mechanism to select a line and Cut it to the clipboard.

Use the Select All command to select the complete file.



Select All (Edit menu)

The select all command highlights the complete file. This allows an easy mechanism to select the 
complete file and Cut it to the clipboard.

Use the Select Line command to select a single line.



Delete Line (Edit menu)

The delete line command deletes the line in which the cursor is positioned.    The end of line characters 
are also deleted.

Use the Select Line command to select the line.



Insert Date/Time (Edit menu)

The insert date/time command inserts the date and time at the cursor position.    The date and time are 
formatted according to the control panel settings.    A single space is inserted between the date and time.

To insert only the date or time the a Template definition feature may be used.



Configure Toolbar (Configuration)

The Toolbar may be configured to include up to 50 items of the users choice.    Any feature listed in the 
menus may be configured to the toolbar using the dialog presented.

The Feature List lists all the features that may be displayed on the toolbar including a Button Separator to 
separate groups of buttons.

The Toolbar List displays the currently selected list of features in the toolbar.

To add an item to the toolbar, select the position in the toolbar list at which the new item is to be inserted. 
In the feature list, select the item to be inserted.    Click the insert button to insert the item in the toolbar.

To remove an item in the toolbar, select the item in the toolbar to be removed.    Click the remove button to 
remove the item from the toolbar.

The items in the feature list are listed in the same order as they appear on the menus.

The default button resets the toolbar list to the default configuration.





Registration
UltraEdit/UltraEdit-32 is a shareware program.

You are limited to 45 Days of use for an unregistered version.

If you find it useful and continue to use it you are obligated to register it with the author by sending $30.00 
(Ohio Residents add $1.65 Sales Tax) to:

                Ian D. Mead
                8209 Chestnut Hill Ct.
                West Chester, OH 45069
                USA

VISA/MASTERCARD Accepted
For VISA/MasterCard orders, include:

1) Name of card holder
2) Address of card holder
3) Name and address of user if different from card holder
4) Expiration date of card
5) Card #.

Credit card orders may be faxed or telephoned to (513) 779 8549,
or sent to my E-Mail address (see below).

CompuServe Registration
UltraEdit may also be registered online on CompuServe by typing GO SWREG and following instructions 
for registering using ID 2662 for UltraEdit and ID 4017 for UltraEdit-32.
 
This will entitle you to an authorization code, the latest registered version, and technical support.

For CompuServe registrations, a newer version is not sent out if the latest version is available on 
CompuServe.

E-Mail Address
Internet:              IDM@iglou.com
CompuServe: 71613,2654
WWW Page: http://www.idmcomp.com/

Registrations for UltraEdit and UltraEdit-32 receive authorization codes that work with both products.    No 
upgrade fee is required to switch from UltraEdit to UltraEdit-32.    UltraEdit and UltraEdit-32 are packaged 
individually for convenience of file size downloading.

Upgrades
Users are entitled to free upgrades for at least 1 year, often longer (of all feature and maintenance 
releases).    If for some reason your authorization code does not work with the latest release and you 
registered within 1 year you will be issued a new authorization code free of charge.

The upgrade fee for previously registered users is $15.00 (Ohio residents should add $0.83 Sales Tax).





Latest Version

The latest version of UltraEdit/UltraEdit-32 may be found in several places:

The following www page:
http://www.idmcomp.com/

In the WINUSER Forum on CompuServe, an official distribution and support online resource for 
future updates.    Search for ULTRAEDIT.ZIP, and UEDIT32.ZIP.

The Windows Users Group Network (WUGNET), operators of the oldest and largest independent 
support resource forum (WINUSER) for Windows Users on CIS with nearly 1,000,000 active 
members is recognized in the press, user groups, developers, and Microsoft as the foremost 
resource for shareware publishers on CompuServe and the Internet.

On the Internet on several sites, including CICA and other sites.



Double Click Selections

UltraEdit allows for selection of text by double clicking the primary mouse button (usually the left button). 
Normally a single word is selected made up of any alphanumeric character or underscore _.

If at the time the primary mouse button is double clicked the control key is pressed, a string is selected 
rather than just a single word.    This can be very useful in selecting filenames, e-mail addresses etc.    The 
characters that delimit the string are configurable in the General Options configuration page.    This 
function works on a single line only. 

These entries, one for the left edge of the text to be selected and one for the right edge specify what 
characters should be used to stop any further text from being selected.    If a space only is specified in 
each field all text either side of    the cursor position will be selected until a space is encountered.

If text is selected when the right mouse button is pressed, a new menu item Open File Highlighted is 
added to the top of the pop-up menu and if selected the file is opened if it exists.



Reload Open Files on Startup

If this option is checked, UltraEdit saves away information about the open files when UltraEdit is closed.    
This information is used to automatically reload the files that were open the next time UltraEdit is started. 
This allows easy reloading of a set of files that are edited on a regular basis.    If UltraEdit is invoked 
automatically for printing, the files are not reopened.



Sort File (File menu)

This command sorts each line of the active file according to the current sort options.    Any size file may be 
sorted.    See the Advanced Sort/Options for details.



Advanced Sort and Options (File menu)

This command allows you to set the sort options and perform a sort of the active file.    The sort is 
performed on the complete file.    The UNDO command is not supported with sort operations.

When this option is selected, a dialog is presented with the following options:

Sort Order
Ascending - This sets the sort for ascending order (a to z, 1-9) and is the default.
Descending - This sets the sort for descending order (z to a, 9-1).

Remove Duplicates
If this is checked, any lines that are found to be identical to another are removed, the first line is 
preserved.    If the Ignore Case    option is set, lines are considered identical if the characters are 
the same with the only difference being the case of them.

Ignore Case
This option should be checked if you want the search to be insensitive to case, i.e. CAT is 
considered the same as cat.    Do not check this option if the sort should consider CAT different 
from cat.

Starting Column
You may specify the column at which the sort is to be based.    The options are:
Column of Cursor or
Specific Column Number

If you select the column of cursor, the sort will be based on the characters at the column number 
the cursor is positioned too at the time the sort is invoked.    Alternatively, you may specify the 
column number (1 being the first column) at which the sort is based.    The default behavior is 
column 1 specified. 

These options are saved between UltraEdit sessions and are used by the Sort File command.



Tools Configuration/Use (Advanced menu)

UltraEdit allows the user to configure up to ten menu items to commands of the users choice.    These 
commands may be any DOS or Windows commands, and when set up appear in the lower portion of the 
Advanced menu.

When the Tool Configuration menu item is selected, a dialog box is presented allowing the user to specify 
the command line and action for each of the users choices.    The following information is presented:

Command Line:
This is the actual command line that will be invoked it may contain a '%F' that will be replaced by 
the full directory specification and filename of the active of the active file.    The file will be saved 
first if changes have been made.

You set up a command to run a compiler and you want to invoke the compiler with the file you are 
currently editing.    If you change files you want the compiler to be invoked with the new file.    The 
compiler is c:\comp\compiler.

Specify the following command in the dialog box:
c:\comp\compiler %F

When the command is executed, the %F will be replaced by the full directory path, filename and 
extension of the active window,    The file will be saved before the command is executed.

The following commands may be used to pass a portion of the full qualified filename:

%P Path only ("C:\project\test\")
%N fileName only ("test")
%E Extension only (".c")

%P%N%E is equal to %F which is ("C:\project\test\test.c") in the example above.

Additionally, the filename and path will converted and passed as the "8.3" short filename 
specification for maximum compatibility with DOS programs.

Working Directory
This is the working directory for the specified command.    If applicable, the process will be started 
with this as it's working directory.    As above, the %P may be used to specify the path.    Note, the 
working directory may be specified for UltraEdit-32 but not for UltraEdit (16-Bit).

Menu Item Name
This is the name of the item as it appears on the Advanced menu.

Windows Program Checkbox
This must be checked if the program being invoked in the command line is a Windows 
application.

Command Output (DOS Commands ONLY)
DOS command output may be optionally captured to a file.    The three options for DOS command 
output are 1) append to existing file (create new file if one does not exist); 2) Replace existing file; 
and 3) Create new file each time the command is run.

As several commands may be configured, it is quite possible the user may wish for some 
commands to always create a new file, while other commands should replace the existing file (or 



append to it).    For this reason, each capture mode (append, replace, new) will create a new file 
for that mode if one does not exist, and each time a command is run, the file for the given capture 
mode will be append to or replaced if appropriate, or a new file created if selected.

Command List Box
The command list box shows the configured commands.    By double clicking on a command in 
this list, the configuration items are pre-loaded with the parameters of this command and may be 
modified.    To keep the changes, the user MUST select REPLACE to overwrite the existing 
command, or INSERT to generate a new command.

If you click on an item, you may delete it by selecting the DELETE button.

Requirements
DOS commands require that certain files exist depending on the operating system:

Windows 95 requires the COMMAND.COM file be on the Windows directory.
Windows NT requires that CMD.EXE be in the path.
Windows 3.x requires that the DOSPRMPT.PIF be in the Windows directory.



Set Colors (View menu)

This menu items allows you to configure the color of the background, bookmark highlighting and the 
regular text color.

A dialog box is presented that shows the current text color for normal text, background and bookmarks.    
By clicking on the color a new color may be selected from the color dialog box.    For the background color 
and bookmark color selections only solid colors are valid.

The background and bookmark colors are used for all files.    The text color is used for all files that are not 
recognized by the Syntax Highlighting.



Show Spaces/Tabs (View menu)

This menu items allows the displaying of spaces, tabs and new line characters as visible characters on 
the screen.    It does change the document, but allows you to clearly distinguish between the different 
characters.

Spaces are shown as: '·'
Tabs are shown as: '»'
New lines are shown as: '¶'

If there is not enough room to show the '»' with the tab, the tab will appear as normal, and non visible.




